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With the supplied Profound software and Manual Part | you have to install the necessary software and drivers before
starting to work with the Profound PDA-USB conditioner.

The following steps are described in more detail below to get familiar with the Profound PDA/DLT software and the
Profound PDA-USB conditioner system:

A) Viewing the Demo File

B) Accessing Help

C) Giving in the relevant parameters and starting a measurement

Minimal system requirements for the PC or laptop used to work with the PDA-USB conditioner:
1) Windows Operating System: WIN10/WIN8/WIN7
2) 3 available USB ports
3) Minimum vertical display resolution 768 pixels

A) Viewing the Demo File
Together with the PDA/DLT software, a PDA demo file has also been installed. You can open this demofile by
choosing Open Pile in the File menu:

§7 Pile Driving Analysi

[File] Input Monitoring PostProcessing Edit Graphs Output Options Window Help

New Pile Ctrl+N p g ﬁ ﬁ |

openric cwwo W

Save Pile CtrleS

Save As Pile (All Data) ™S “ p “’ “ ﬁ “ “ V = &:; % pros r
Save As New Pile (Input Data Only) By Pt W Porr | Pe Paz Parr | B ’\" =L

Print Active Window ad-e Driving Analysis {Fesults per Blow | Penetation Graphs |
Print Preview mpedance { Blow Number: 1) oL

Open PDA Signal

Open PDA Signal {Old Format) »
Export Signals or Results »
Add PDA Signals to Project

Open Word Report

Bt

Ctri+Q

I~ Shom Cross Hair %= -0,3%8 -,
I ShowMarkers ¥ Show Giid

2/12 | Manual PDA-USB Part Il | 01-03-2020

Profound BV IS0 9001:2015 certified VAT number NL806166800B01
Mozartlaan 46-A Tel. +31 (0)182 640 964 IBAN NL79 RABO 0116 9166 13
NL-2742 BN Waddinxveen info@profound.nl BIC RABONL2U

The Netherlands www.profound.nl Chamber of Commerce Rotterdam 27242091



profound

INNOVATIVE MONITORING EOUIPMENT FOR PROFESSIONALS

Followed by opening ® Program Files (x86) ® Profound = PdaDIt ® PDA_Project ® Demo-43.pda:

| » Computer » 0S(C) » Program Files (86) » Profound » PdaDit

» PDA_ Project »

Zoeken in PDA_Project
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Pile Number Demo—43

Blow Humber 7

Pile Penetration 0,000 [m]
Mezsuring Length 21,500 [m]
Total Pile Length 22,600 [m]
Wave Velocity 4000, 00 [m/s]
Blow Count 0,0 [b1/25em]
Blow Rate 33 [bl/min]
Max. Compr. Meas. 25 [MPa]
Driving Resist. 6570,0 [kN]
Soil Model Case (Max)
Transferred Energy 55,2 [kNm]
Rated Znergy 108,0 [kNm]
Centricity Blow 36,6  [%]
Force/Vel. x Imp. 1,266 [-]

ﬂﬂlﬂlﬁﬂﬂﬁﬂﬂ W Include for Pracessing [ Show included blaws anly

B) Accessing Help

PDADLT has an extensive Help system. To view the Help system, select Help from the Help Menu or press F1
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C) Starting a new PDA or DLT measurement with the Profound PDA-USB system and your PC

Before starting the measurement in the PC software, please perform the following actions:
- Connect the PDA-USB conditioner with the PC (see also Manual Part I: step 10 and 11)
- Mount the sensors on the pile (see Part lll - Mounting of PDA-transducers)
- Correctly connect the sensor cables to the PDA junction box
- Connect the cable reel to the conditioner

Then continue on your PC:
1. Run the Profound PDADLT Software with HASP key inserted.
2. Select New pile from the File menu. The Pile Project Data will be shown:

File Input Monitoring Post Processing Edit Graphs Output Options Window Help
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[Blow Count 0,0 [bl/25em]

~ Project Dir |Blow Rate Q [bl/min]
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Soil Model Case (Max)
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.0

2 Vel. x Imp. o I-
~ Pile Data Fil orce/Vel. x Imp -1
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[ale Cancel
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[~ Show Cross Hair  %=-0693
I~ ShowMakers [ Show Giid

3. Insert the pile name in the tab Data Storage (for instance pile_pdaUSB). The program will create a
directory and files for the measurement. The standard location will be: \Program Files
(x86)\Profound\PDADLT\PDA_Project\

= % - - & F 3 -
@{\_}'| . ¥ Computer » OS5(C:) » Program Files (x86) » Profound » PDADLT » PDA_Project » pile_pdalSB
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4. Select the tab General Data to give in additional measurement information:

FW Pile Project Data - ‘ = | B ﬂh.‘
Diata Storage l
Header |F'i|e Diiving Analysis
TestDate  [132202 Rematks
Date & |[igzzoz -]
lza 17.37.35 B

Project ID ,7 Client Mame ,7
Operator ,7 Contractor ,7
Site Mame [
Site Location ,7

0K Cancel

Press OK to continue. The file name and location of the file will be shown in the caption of the window.

h

5. Select from the Input menu the option PDA Data.
Give in the relevant parameters below the tabTest Data and choose Apply:
o Start of Blow number: usually 1
o Blow count unit: distance marking on the pile for penetration recording (only for PDA)
o Penetration reading: Pile penetration at the first blow

F: o
¥/ PDA Data [m25m)
Test Data ]Eile ] ﬂammer] Sail ] Iransducers] Recaorder

Test Data

Pile Nurnber |pile_pdalI5E

Start of Blownumber |1—

Blaws Count Uit ﬁﬁ— [ra]
Penetration Reading W— [m]
Carrection ﬁﬁ— [m]
Penetration File Toe W [rn]

[~ Batter pile

Alarmsz-

[~ Compression Slarm [0 [MPa]
[~ Tension Alarm 0 [MPa]

Cancel | Apply |
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Give in the relevant parameters below the next tab Pile and choose Apply:

(e]

Total Measuring Length: the total measuring length in the menu "PDA data" is the total length

from the position where the sensors are mounted up to the pile toe.
Below the tab Transducers you need to enter the distance from the pile top up to the position
where the sensors are mounted. The summation of these two parameters is the pile length. In

short:

Total pile length = measuring length + distance from top

The total pile length can be made visible in the mrf-setting:

v —
~ %:9%39 i Eﬁ ‘ﬁ

Resultz per Blow l Penetration Graphs ]

Pile Number p_manual

Blow Number €

Pile Penetratiom 0,000 [m]
Measuring Length 20,000 [m]
Total File Length 21,080 [m]
HWave Velocity 4000,00 [m/s]
Blow Count a,0 [Bl/Z5cm]
Blow Rate €3 [bl/min]
Max. Compr. Meas. [a] [MPa]
Driving Besist. 855, [kN]
So0il Model Case (Max)
Tranaferred Energy o,1 [kNm]
Rated Energy 0,5 [ kMm]
Centricity Blow 100,% [%]
Force/Vel. x Imp. 0,048 [-]

o Stress wave velocity: see pile

material parameters below

Number of periods: starting value is 4

Cross Section data: a calculation help for the cross section of the pile

Pile material parameters. With unknown parameters a guideline is:

= for concrete is 39200 MPa. Density 2450 kg/m3 (Stress wave velocity 4000 m/s)

= for steel 206000 MPa. Density 7850 kg/m3 and Stress wave velocity 5123 m/s (in
accordance with ASTM D 4945 —08)

¥7 PDA Data =]
TestData Pile lﬂammer] Sail ]Iransducers] BRecorder
Pile: D ata
Tatal Measzuring Length ,20— [rm]
Shess Wave Velocity W [ms]
Mumber of Periods [«

[~ Segmental Pile

Cross-Section Data at Transducer Level

Cross sechion type Sauare [solid) =
Side Tap 3200 [mm]
Side Battorn 320.0 [mm]

Material Properties at Transducer Level

Matenial Cancrete =
Young's modulus 40000 [MPa]
D ensity 2400 [kaéma]
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7. Give in the relevant parameters below the next tab Hammer and choose Apply. This tab is more relevant
for PDA measurement, because the efficiency of the driving process can be analysed.

i )

k7 PDA Data =

Test Qata] File  Hammer lﬁuil ] Iransduu:ers] Recorder

Harmmer D ata

Hammer Mame |Delmag 46-3

Mass of Fam 4500 [ka]
Rated Energy Hammer 1EE [kMm]

Iv Diezel hammer

Please note: use the correct setting for the check box Diesel hammer, as the signal processing of the
measurement is different for diesel hammers.

8. Give in the relevant parameters below the next tab Soil and choose Apply. Select the calculation method
for the soil resistance. This gives a rough estimate for the static soil resistance. Common practice is to
use the Standard Case method. Enter the Case Damping value for the toe soil type. In the online help

you can find more information including case values.

-

¥/ PDA Data ==

Testgata] Pile ]ﬂammer Soil lransducers] Recorder
Soill Resistance Data

tdethod Standard Casel

Standard Caze Method

Caze Damping Jc 0100

9. Give in the relevant parameters below the next tab Transducers and choose Apply.
o Enter all the sensitivities and serial numbers of all the sensors. The specific data is provided on the
supplied calibration sheets.
Please note: for the strain sensor the calibration factor is the Static Calibration Number
from the calibration sheet!

Calibration data:

Static Calibration number : 4.30

Sensitivity (3) © 215 WY, pStrain
Zero load output o 1556 Wi Volt
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o Enter the measured distance from the pile top to the sensor location. A distance of 3 times the

pile diameter from the top is a good mounting position for the sensors to equalize the stress

distribution over the complete pile cross section. The minimum value defined in the ASTM D 4945

—08, is at least 1

.5 times the pile width.

o Enter the cable length of the cable reel. The standard cable is Yellow AWY16. These input values

will be used to compensate for the influence on the sensitivity caused by the cable resistance.

o The data given in the Expected Maximum Value (first blow) are used to calculate the first gain

settings. The acceleration and stress values depend on the material properties of the pile and are

directly related to the data given under the tab Pile in this PDA Data menu. Make sure to give in

the correct data.

or

¥7 PDA Data
Test Qata] F

Transducers

1. Acc. 1
2. Strain 1
3. Acc. 2
4. Shrain 2

Cable
Cable Type

Cable Length

Digtance fromTop

ile ] ﬂammer] Soil

Tranzducers l Recorder

Sernial Mumber: Calibration Factor:
|4 C04a1 |0,0290

|5TO455 |4.00

|sC0482 |0.0296

|5TO484 |4.02

1.08 [m]

“ellow 216

50 [m]

E xpected b aximum Yalues [first blow)

=

'

=

[mtfg]
[
[V /g]
[

Accelereration 20000 [méz2]
Stress E0 [tMPa]
(] Cancel Apply

You are now ready to start measuring with the Profound PDA/DLT-USB system
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10. Go to the Monitoring menu and select Start Monitoring. The Monitoring Control dialog that appears,
has to be used for:

A. Adjusting the trigger level. Advised is to reduce the trigger level to 2% with the above advised gain
settings and 4 Steps setting 2 and 1 as shown below.

B. Selecting the trigger channel. Default is acceleration channel 1. If a sensor fails, always change the
trigger channel to a working sensor.

C. Deactivating non-working sensors. If a sensor is not properly functioning, turn it off by deselecting
the box. Thus this sensor will not further disturb the PDA signal processing during the
measurement.

D. Input of the pile penetration. The Add 0.250 [m] button (= blow count unit) must be pressed for
each penetration interval (only relevant for PDA-testing).

W Manitering Control

[&=]
A +8¢  Tng  Amplification 4 Steps
1ol CW | [ B&  [rom 2=
2 Shainl W | [ ©  [e5a0 =
dacc2 W [ S FZTT] [z
45an2 V| [ ©  [Ez540 1
Feading [m] Penetration [m] Blow Mum. Trigger Level [%]
g
0,000 {0,000 1 [z =
Changs D sggoos Chomee | A _Stat |
Feading [m] Number

Press <Start> in the dialog and the measurement will start. The PDA system is now waiting for a
trigger.

11. After the first trigger the monitoring control dialog will display the signal amplitude for the sensors
connected. The dialog below shows a good example of level control with no need to increase the
amplification. The optimum signal amplitude is 20% of the total amplitude. During pile driving the
magnitude for both acceleration and strain will usually further increase. The signal quality will not
improve by increasing the gain.

In addition, the value 2 and 1 below the '4 steps’ are good starting values.

Profound BV

Mozartlaan 46-A
NL-2742 BN Waddinxveen
The Netherlands

i Meonitoring Centrol
By +3  Trig:  Amplification 4 Steps
1acel W | | = [75.000 E=
2.Stain1 | | [E3540 [
3oz W | [7.000 [2
4.5hain2 W || € [3540 [
Fieading [m] Penetration [m] Bl Mum. Trigger Level [%]
0,000 [o.ooo [z2 [2 = -
Chatge #dd 0,250 ; Q
Reading [m]
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Profound BV
Mozartlaan 46-A

The PDA software will provide information dialogs to increase or decrease the amplification settings.
The amplification settings can be changed with the spin buttons. Gain switching should be kept to a
minimum except when an overload occurs.

Please note: In case you would like to check the functioning of the system, use a small hammer to give a

soft blow on one of the acceleration sensors.

The monitoring dialog can be decreased in size for convenience:

Reading [m]

F?' Monitering Control

Peretration [m]

{3.000

{3.000

=

addoosn| _ Stat |

[rm]

Congratulations, you have successfully started a PDA/DLT.

Consult for additional info the Online Help
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PDA example
An example with a simulated PDA signal is displayed below.

.
§7 Pile Driving Analysis, C:\Program Files (x86)\Profound\PDADLT\PDA_Project\pile_pdallSB\pile_pdaliSB.pda =)
File Input Monitoring PostProcessing Edit Graphs Output Options Window Help

e EE R P rEwS

(OB f o (55 o g i 5 5 £ (9 48 g

Clfepe =20

Pile Driving Analysis Results per Blow | Penciration Graphs |
Force and Velocity x Impedance ( Blow Number: 62 ) Tile Number pile_pdalSB
Blow Number &z
Pile Penesratian 3,000  [m]
Wave Velscity 4000, 00 [m/s]
Count in progress &1
s Blow Count 0,1 [b1/25cm]
= Blow Rate &7 [bl/min]
- Max. Compr. Meas. 29 [MPa]
= Driving Resist. 2552,2 [kH]
= Scil Model Case Standard
2 Transferzed Energy 21,7 [kim]
. @ Rated Energy 166,0 [kNml
Centricity Blow 74,0 [%]
=15 Force/Vel. x Imp. 0,078 [-1
=
@ —
= 7 Monitoring Control @
w

. B Trg Amplfication 4 Steps
tAel O N ¢ [weom | [
iswant @ [ WM [esw | B
a2 [ WEM © [weom @
astanz @ [ WM © [ieoso 2

| | |
30 35 40

]
Reading[m] | | Penchation [n] | ~Blow Hum. — | Trager Level 2]
Ui O] ﬁa,uuu T ﬁauua T ﬁsz —‘ (|5 : —‘ il

5

L

[~ Show Cross Hair = 30,346 Y=0. Thanon Elé“atﬁe Start
[¥ ShowMarkers [ Show Grid iea o {0250 [m], Humber Stop
s S 1

T~

The check box Show Markers show additional information in the graph

Shown below is also the dialog message box notifying to reduce the gain of the strain amplifiers. The blue bars show
the overload at -5 Volt:

-
Pile Driving Analysis, C:\Program Files found! : 2 USEsi [ [ [
ng Analy: g g

File Input Monitoring PostProcessing Edit Graphs Output Options Window Help
CIEC2EIE] L S=0
Time graphs /7 Monitoring Control ==
Ui e
2424. 4 2 4154 -4 o 1 oot 15 || 5
Pile Drivi "% ¥ = & Jeamo [ | Penetration Graphs |
Force and Velocity x Imped2| 5 syain1 @ . e lm Fj pile_pdalUSB
248
TN e i il O e R
isn2 ¢ NN~ [ [ PR B s
&7 [bl/min]
Meas._ 1z [MPa]
Fleading [m] Penetration [m] — [~ Blow Num. — ~ Trigger Level [ —— | [, 05" Fotirines
ﬁm,zsn —I hwa,zsn —I [|249 —I (5 :,'—‘ = Case Standard
Energy 8,8 [kNm]
: Change add u,z5u| S [ S
=15 Reading ] Humber Stop | ||x Tme. 0,849 )
=
|
5 ’ ~
0.0 & e e A baton S
5
=t
+
2
| |
30 35
Time [ms]
[~ Show Cross Hair  Time = Force =
[¥ ShowMakers ¥ Show Grid
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Appendix 1: Trouble shooting

Error message ‘MCCADC Card not found’

If you start measuring with the PDA/DLT PC software and the PDA-USB T - M
conditioner connected and this message pops up, the specific PDA-USB )
conditioner is not found.

Please do the following:
1. Close the PDA/DLT PC software
2. Run the InstaCal™ program. Click on Start > All programs >
Measurement Computing » InstaCal.

3. The detection window below always needs to appear. Click ‘OK’.

r— 3
Plug 2nd Play Board Detection [

The following plug and play devices hawve
been detected...

[¥1USB-16085 (166445

Check those devices you wish to hawve
added to the corfiguration file.

4. Inthe window ‘Board Selection List’ select USB. Verify that the field ‘Board Number’ states value 0. In case the
PDA-USB conditioner is not detected, press the refresh button. 2

File Install Calibrate Test Help

FEema ge s 9

™ pCBoard List
E@D Universal Serial Bus

m Board# 0 - USB-1608G (166df45)

5. Close the InstaCal software.
6. Run the PDA/DLT software and try again.

PDA-DLT License error

If your program does not run because of license errors, please check the (67 PDA-DLT License =
following:
= Has the HASP driver been properly installed (without the HASP key Lsense sode
inserted)? HU33-CLST-ASARKHFA
» Insert the HASP key in an USB port before running the PDA/DLT program = e

PDA/DLT software does not respond to the instrumentation anymore
= Check the lights on the box
=  Check the connection of the two USB cables between conditioner and PC
= Check the power down features of your laptop. All power save options should be switched off for PDA/DLT

measurements, in particular for the USB ports.
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